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1 About Communicator for Desktop 

Communicator for Desktop is a native Windows or Mac client for Unified Communications, 
providing the following communication features: 

 Instant Messaging and Presence 

 Voice Calling 

 Video Calling 

 Desktop Sharing 

 Primus HPBX Call Settings 

https://primus.ca/
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2 Get Started 

This section contains the essential information for getting started with Communicator.  End 
users need to ensure their systems meet system requirements as outlined in section 22 
System Requirements. 

2.1 Installation 
Primus provides the download of the installer via the online Hosted PBX portal at 
https://voice.primus.ca under Advanced View -> Your Phone -> Unified Communications. 

Windows 

 Double-click the installer executable and follow the installation instructions. 

 Launch Communicator. 

OS X 

 Double-click the disk image. 

 Copy the application into the Applications folder. 

 Launch Communicator. 

2.2 Sign In 
When you first launch the application, you are prompted to sign in. 

1) Enter your Hosted PBX user name and password (the same username and password 
used to log into the online HPBX portal at https://voice.primus.ca). 

2) Select whether you would like Communicator to remember your password. 

3) Select whether you would like Communicator to sign you in automatically on 
subsequent launches. 

4) Click Sign In. 

You can also access Help and Preferences directly from the login window. 

NOTE:  If you choose automatic sign in, you are automatically signed in and taken to the Main 
window upon subsequent Communicator launches.  Otherwise, you are presented with the Sign 
In screen when launching the application. 

The Login window offers the last used username, but the password shall be automatically 
filled in only if you have checked the Save password check box.  If multiple people use 
the same machine, only the last password is entered as a security measure.  If you 
change the username in the Login window through editing it, or using the drop-down list to 
pick another one, Communicator will not fill in the password; you are always expected to 
type it in.  This also applies when re-selecting or re-entering the last used username. 

It is not a supported configuration to run many Desktop clients at the same time with the 
same account. 

https://primus.ca/
https://voice.primus.ca/
https://voice.primus.ca/


 

PRIMUS UC COMMUNICATOR DESKTOP USER GUIDE R22.5.0 
©2018 FUSION. ALL RIGHTS RESERVED.    PAGE 8 

2.3 Main Window 
When you start Communicator for the first time, your Contacts list is empty.  Use the 
Search and Dial field to find people and add them to your Contacts list.  Contacts can also 
be added manually by clicking the Add button.  Client windows can also be set to always 
use the Main window menu option.  The dial pad is also integrated with the Main window. 

Communicator uses tabs for new chat sessions.  The Search and Dial field allows 
searching for contacts as well as making calls using phone numbers.  The table that 
follows the images describes the key icons used in the Main and Communications 
windows. 

 
Figure 1  Tabbed Main Window 

Icon Usage 

 

My Information – View and update your information, for example, your 
presence, avatar, and location. 

 
Contacts – View your contacts. 

 
My Room – This is your permanent communication room.  Participants can 
dial in to your audio bridge. 

 
Call History – View previous calls. 

 
Chat History – View previous chats. 

 
Full Enterprise Directory – Show all contacts of the directory. 

 
Dial Pad – Make calls (it is integrated with the Main window). 

  

Preferences – Use for quick access to preferences and Call Settings such as 
Call Forwarding. 

 
Chat – Start an instant message conversation with a selected contact. 

https://primus.ca/
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Call – Make an IP audio call to a selected contact. 

 
Call from Phone – Make a Click To Dial call from your desk phone (or 
secondary device). 

 
Video Call – Make a video call to a selected client (VoIP). 

 
Share – Share either the whole screen or an individual application. 

 
Menu – Open Communications options. 

 
Add – Add a contact, group, or conference. 

 

My Information 
 Double-click the avatar to upload a picture or use a right-click menu. 

Presence 
You can set your presence to one status indicated in the following table. 

Icon What it means 

 
The green presence icon indicates that the user is online and ready for communication. 

 
The yellow presence icon indicates that the user is online but has been idle or away from 
their computer for more than ten minutes. 

 
The red presence icon indicates that the user is busy and does not want to be disturbed. 

 
The grey presence icon indicates that the user is offline and the only available contact 
method is calling or leaving a chat message. 

 
This icon indicates that the contact is busy on a call.  This is an automated presence 
status. 

 
This icon indicates that the contact is busy in a meeting.  This is an automated presence 
status.  The Busy – In Call status overrides the Busy – In Meeting status so this one is 
only seen if there is a meeting but no call. 

 

Communicator can automatically update your presence to the following: 

 Busy – In Call 

 Busy – In Meeting (Windows only) 

 Available (desk phone) 

 Available (mobile) 

 Away on mobile 

 Offline and busy in call 

https://primus.ca/
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Location 
Your location is automatically determined by your public IP address; however, you can 
manually set the text to appear for your location and time zone using the location dialog 
box. 

2.4 Communications View 
After starting communication with one or more contacts, a new tab is displayed for chat.  
The call window is also integrated with the Main window chat tab by default.  You can 
separate a tab on to a different Communications window by dragging and dropping it 
outside of the Main window.  From this view, you can perform the following actions: 

 Escalate a chat to include audio, video, and desktop sharing 

 End an audio or video call 

 Open the dial pad 

 Mute your microphone 

 Adjust your speaker volume 

 Place a call on hold 

 Transfer a call 

 Toggle between speaker and headset 

If you are using several monitors, Communicator opens the Communications window as 
well as notifications on the same monitor as the Main window. 

You may have up to 20 active communications on Windows and on OS X.  If the 
maximum is reached, the main window’s top section warns user with the following 
message:  “The maximum amount of communication windows has been reached.  Please 
close some to open new ones.” 

If an incoming call is answered while this warning is shown, the client closes the chat 
session that has the longest time since its last activity. 

2.5 Start Chat 
Start a chat tab using one of the following methods: 

 Double-click a contact from the Contacts list or search results. 

 Right-click one or more contacts from the Contacts list or search results and click the 
Chat menu item. 

 On the Chat History list, double-click a chat entry. 

 In a Communications window, click the Chat button (this does not open a new tab). 

2.6 Send File 
 In a one-to-one chat, transfer files by clicking the Send File button in the 

Communications window or use the “drag and drop” method so that they are moved 
to the Communications window. 

2.7 Send Email 
Right-click a contact from the Contacts list or search results and select the Email menu 
option.  The contact must have an email address defined for this feature. 

https://primus.ca/
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2.8 Make Audio or Video Call 
Make an audio or video call using one of the following methods: 

 Right-click one or more contacts from the Contacts list or search results and select the 
Call, Call from Phone, or Video menu item.  The menu items depend on service 
provider settings. 

 Right-click one or more contacts from the Contacts list or search results and click the 
Call, Call from Phone, or Video.  The menu items depend on service provider 
settings. 

 Enter a phone number in the Search and Dial field. 

− Press ENTER to start a VoIP call. 

− Click the Call, Call from Phone, or Video button. 

 Open the dial pad, enter a phone number, and then click the Call, Call from Phone, 
or Video button. 

 On the Call History list, double-click a call entry. 

 In the Communications window, click the Call, Call from Phone, or Video button. 

 When viewing a contact’s profile, click the Call, Call from Phone, or Video button. 

NOTE:  If dialing a phone number that requires additional dual-tone multi-frequency (DTMF) 
tones (for example, a conference bridge), you can type the numbers on your keyboard while the 
Communications window has focus or open the dial pad in the Communications window. 

2.9 Share Your Application or Desktop 
Share your desktop by following these steps: 

1) Click the Start Sharing button in the top of the Communications window (if share 
panel is not visible).  The Share button is visible by default in My Room also.  This 
button is available when your service provider has enabled share on your account.  
The share selector window opens. 

2) Select the application to share or the entire screen of a particular display and click the 
Start Sharing button. 

2.10 Active Communications 
Active communications appear at the top of the Contacts list in the Main window.  This 
area provides an easy view to see the people with whom you are communicating.  By 
default, there is no separate call tab but call is shown in the Active Communications area 
in the Main window (where the call can be fully controlled in the Desktop client).  It reduces 
the number of Communications windows; however, a separate call window can still be 
opened using an Active Communications menu.  The following is also available in this 
area: 

 Double-click an active communication item to bring this Communications tab to focus 
if the call window is separately shown.  If the call window is integrated, you can use a 
menu option to show it separately. 

 See who has sent you a chat message, but only after you accept the chat session.  
Before the chat session is established, the chat items are not visible in active 
communications but a history badge is visible. 

 End a call. 

https://primus.ca/
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 Mute the microphone. 

 Place a call on hold. 

 Merge two calls or transfer by dragging and dropping calls onto each other. 

 Transfer a call. 

 Make conference calls. 

 See call recordings. 

 Park and retrieve calls. 

 Set audio device to headset or speaker.  For more information, see section  
15 Preferences. 

You can right-click the “More” icon of an active Communications item (icon with three dots) 
for additional options while a left-click offers additional call management options for this 
call as well as other options when available. 

2.11 My Room 
My Room is an always available and permanent room you can use to chat with anyone 
that joins. 

You and your attendees can click the Call or Video button to have Communicator 
automatically dial in to the conference and enter the appropriate entry codes.  Note, you 
cannot hear any DTMF tones when dialing into My Room (the call is made automatically). 

You can invite others to your room by dragging and dropping them from the Contacts list 
into the My Room tab.  You can also use the right-click menu on the My Room icon in the 
top-right corner of the Main window or the My Room information area to copy an invitation 
link for guest users (anyone outside your organization or those inside your organization 
without Communicator).  They can then click the link and join the meeting through a web 
browser.  Guest users must be separately accepted for each session. 

Contacts join your room by right-clicking your name on their contact list and selecting Join 
Room or by an invitation you sent. 

Email My Room Invitation menu results in working links for guest users only.  
Communicator users are recommended to use Copy My Room Invitation links; however, 
the links may not work in all applications as they were originally intended for Outlook. 

You can also copy the attendee list to your clipboard using the related participant menu 
available via the options icon (three dots). 

In My Room calls, the owner can also see active speaker info with the Mute/Unmute icon. 

My Room can also be moderated, see section 6.13 Moderator Controls for more details. 

2.11.1 Select Audio Devices 

If you have multiple audio devices available for your microphone or speakers, select the 
preferred audio device before starting a call. 

Windows 
3) Click the Preferences icon in the Main window. 

4) Select Audio/Video. 

5) Set an Output (playback) device for when using speakers. 

6) Set an Input (recording) device for when using speakers (microphone). 

7) Click OK. 

https://primus.ca/
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OS X 
8) Select Communicator from the main menu. 

9) Select Preferences. 

10) Select Audio. 

11) Set a playback device (speakers). 

12) Set a recording device (microphone). 

13) Click OK. 

If “Use default” is selected, then Communicator uses the default device set in the 
operating system preferences.  For Windows, if “Default Communication Device” is 
defined, it is selected over the “Default Device”.   

If you are using headsets, you can also select a separate device than the headset for 
alerting incoming calls. 

Note that on OS X it is recommended to disable “Use ambient noise reduction” in System 
Preferences to reduce echo. 

https://primus.ca/
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3 Contacts 

Contacts are the people with whom you communicate and, in most cases; you see their 
presence and share your presence with them.  There are three types of contacts: 

 Contacts – Actual people with whom you communicate. 

 Conferences – Audio or video conference bridges that you use to communicate with 
others.  Silent dialing into the bridge also applies to these contacts if enabled by your 
service provider.  Conference contacts are regular contacts and are added just like 
regular contacts. 

 Groups – Containers of contacts and/or conferences. 

There is no hard coded limit on the number of contacts.  The more contacts are added the 
more memory and processing is needed.  The more contacts are added, the more difficult 
it is to find people without searching.  Live search can be used instead of a very large local 
contact list while keeping memory and processing requirements to a minimum. 

3.1 Add 
When you sign in for the first time, there are no contacts on your contact list.  Add a new 
contact at any time by selecting the Add Contact item from the menu or choose the Add 
Contact button from the Main window. 

In the Add Contact dialog box, enter the contact’s information and then click Add Contact.  
By default, your presence information is always shared with a new Primus UC user in your 
organization. 

When receiving a buddy request from another Primus UC user, there are two buttons for 
accepting and rejecting the request.  Dismissing the buddy request window only ignores 
the request for the duration of the login session.  It reappears after the next login. 

However, you can always share your presence information later by selecting Subscribe on 
the right-click menu for a specific contact in the contact / directory list.  Note that the 
contact must accept your subscription request for you to establish the presence 
relationship successfully. 

The newly added contact appears on your contact list. 

Add a conference contact by clicking the same button you did for Add Contact and 
choosing the Add Conference menu option.  A conference contact is a special contact 
used for conference bridges to avoid remembering PIN codes and conference number, for 
example, recurring conferences.  Just create a contact for the weekly conference, add a 
conference bridge number and PIN, and join the conference just by right-clicking the 
contact or choosing it and clicking the Call button. 

Choose the Add Group menu option to add a new group to the contact list. 

3.2 Edit 
Edit a contact by selecting the contact first.  After you select the contact, right-click 
anywhere in the area of the selected contact and a menu of options appears which allows 
you to either view or edit the contact profile.  In View mode, click the Edit button to go to 
Edit mode.  This base principle is the same for normal contacts, conference contacts, and 
groups.  Note that only some fields are editable.   

https://primus.ca/
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 Unsubscribe removes the presence relationship between you and that contact.  This 
means you do not see the contact’s presence information and your contact does not 
see yours.  To re-establish the presence relationship, select Subscribe.  An 
unsubscribed contact remains on the contact list and is always shown without an icon.  
Any contact that is not presence-enabled is shown in the same way. 

 Delete contact removes the contact from your contact list. 

 View Profile opens the Contact Information dialog box where you can add, edit, or 
remove information.  This works for both normal and conference contacts. 

 For groups, choose the Edit menu option to rename a group. 

Once done with all changes, click the Save button. 

3.3 Filters 
You can filter contacts in two ways: 

 Use the filter field to search by contact name.  The contact list is filtered in real time as 
you type. 

 Alternatively, use the filter menus available by right-clicking the Contacts icon in the 
left pane to display only specific types of contacts such online contacts.  You can also 
sort contacts based on first or last name or choose whether to display the contact’s 
avatar in the contact list. 

 When you make a contact your favorite, the favorite group shows on top of the 
contact list and cannot be hidden. 

 When you delete all your favorite contacts, the favorite group does not show 
anywhere. 

 When you have even one favorite marked, you see the Favorites group. 

https://primus.ca/


 

PRIMUS UC COMMUNICATOR DESKTOP USER GUIDE R22.5.0 
©2018 FUSION. ALL RIGHTS RESERVED.    PAGE 16 

4 Presence 

For each contact you have subscribed to, you can see their presence.  Similarly, your 
contacts can see your presence on their contact list. 

Presence means that your friends are able to see whether you are available to 
communicate, for example, “I’m busy” or “I’m available”. 

Icon What it means 

 The green presence icon indicates that the user is online and ready for communication. 

 
The yellow presence icon indicates that the user is online but has been idle or away from 
their computer for more than ten minutes. 

 The red presence icon indicates that the user is busy and does not want to be disturbed. 

 
The grey presence icon indicates that the user is offline and the only available contact 
method is calling. 

 
The question mark indicates that a subscription is pending and the contact has not yet 
approved sharing their presence. 

 
This icon indicates that the contact is busy due to a call.  This is an automated presence 
status. 

 

This icon indicates that the contact is busy due to a meeting.  This is an automated 
presence status.  The Busy – In Call status overrides the Busy – In Meeting status so this 
one is only seen if there is a meeting but no call. 

 
This icon indicates that the contact is only available on mobile Communicator. 

 
This icon indicates that the contact is only available on a compatible desktop phone, and not 
Communicator. 

 
This icon indicates that only the mobile client is online and in the away status. 

 
This icon indicates that the user is in a call but is not logged in to presence and chat. 

 

The avatars are retrieved at login, when the contact is added, and when the contact 
comes online. 

If you see an error message at the top of the Main window “Chat Unavailable”, it means 
that the connectivity has been lost for chat and presence; however, you can still make 
calls.  This is typically temporary and caused by a brief network disruption or change in 
connection to another wireless access point. 

If you have installed the Outlook plug-in, you can have the Outlook calendar automatically 
change your presence to Busy – In Meeting by enabling this in the Preferences → 
Extensions tab. 

The presence update is only triggered by appointments and meetings that are in the Show 
me as busy state. 

Location in presence is done based on the IP address that the machine is using.  The IP 
address is mapped to a physical location.  The mapping provider is continuously working 
to improve the accuracy of the location.  Change the location manually by clicking the 
avatar (if presence controls are not already expanded) and then the location icon to go to 
the manual location and change the view. 

https://primus.ca/
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5 Chat 

5.1 Chat View 
When you initiate a chat, the Chat tab inside the Main window opens.  Chatting with a 
contact is possible only when you are both online.  If your contact initiates a chat, you see 
a pop-up notification in the bottom right-hand corner of the screen.  If you close the Chat 
tab and open it again, sent chat messages are shown in the tab as chat history.  A typing 
notification is also shown. 

When the chat opens, you see the contact’s information at the top of the screen. 

At the top of the message area, there are five links:  Yesterday, Last week, Last month,  
All history, and Delete history.  From these links, you can load history from your local 
storage and different timeframes.  Depending on your history, some links may not be 
visible if there is no data to show.  You can delete the history using the Delete history link. 

In the text field, you can add a emoticon.  Emoticons can also be added by manually 
entering the corresponding characters that represent that particular emoticon.  You can 
send text by pressing ENTER. 

The full set of Emojis is also supported and they are rendered as ordinary emoticons when 
received.  Spell checking is also supported and can be disabled in Preferences.   

To enter a line break in the text field, you can use the following key commands: 

 CTRL+ENTER (command+enter on Mac) 

 SHIFT+ENTER 

 ALT+ENTER 

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection 
for a menu to copy or paste the text to or from the Chat tab. 

All sent and received chats are stored locally in the chat history and a message history 
feature provides multi-device enhancements so that messages sent or received in other 
own devices can also be shown. 

5.2 File Transfer 
File transfer functionality is only accessible through the Chat tab. 

14) To open the File Selection dialog box, click the Send File button located to the side of 
the text field. 

15) From the dialog, select the file to be sent, and then click Open.  You can also drag 
and drop a file into the Chat tab. 

16) Once the file offer is issued and during its transfer, you can cancel the transfer (at any 
time) by clicking Cancel. 

17) Accept an incoming file transfer by clicking the Accept button. 

18) Reject the file transfer offer by clicking the Decline button. 

After the file transfer has completed, the received files can be opened or viewed in the file 
manager by using the File received, click to open, and Show in folder links. 

In error situations, partially received files are not deleted automatically. 
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5.3 Group Chat 
Start a group chat by “multi-selecting” and right-clicking the Main window contact list.  
More people can be added later to the chat by “drag and drop”.  Only the owner can add 
more participants.   

A group chat works the same way as a one-to-one chat in a tabbed view.  All messages 
from anyone are sent to everyone else.  All contacts need to be online to be able to 
participate in a group chat.  You cannot invite an offline contact or a contact that is not on a 
device that supports group chat.  This does not affect the group chat in any way. 

A group chat history is saved both in My Room and in ad hoc chat rooms and is available 
to view later in the Messages tab of the Main window. 

In the text field, the contacts’ names appear in different colors to easily distinguish 
between who is writing. 

Only the newest chat room messages are stored on the server.  One-to-one chat 
messages are only saved locally.  Messages sent from your other devices are also shown. 

Deleting a chat room is not supported. 

Chat rooms can be moderated by the owner.  Use the right-click menu options to remove 
a participant from your chat room.  If needed, the removed participant can join later.  The 
removal also applies to desktop share sessions. 

Typing notifications are not supported in group chats. 
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6 Audio and Video Calls 

The following table describes additional Communications window icons and explains what 
you can do with them, for voice and video calls. 

Icon What you can do 

 
Add or remove video from the call. 

 
Mute your microphone by clicking the mute icon. 

 

Put the call on hold.  Note that if you hold the call, the other party cannot “unhold”.  This 
freezes a video call to the last frame of the video feed.  In both voice and video calls, 
this is communicated to all parties by a notification appearing in the middle of the 
screen. 

 
Use this icon to access the Call Options menu.  In the Call Options menu, you can find 
different actions to use for a call depending on your settings and your service provider. 

 

In the Options menu, there are the following options: 

 Transfer a call to a third party. 

 Put the call on hold.  Note that if you hold the call, the other party cannot “unhold”.  
This freezes a video call to the last frame of the video feed.  In both voice and video 
calls, this is communicated to all parties by a notification appearing in the middle of the 
screen. 

 Adjust the volume bar to adjust the volume.  Dragging it all the way to the left mutes 
your speakers. 

 Enter additional digits using the dial pad at any time during the call (for example, to 
insert a conference number).  The dial pad is not movable. 

 Toggle between the audio headset and speakers. 

 Add participants to the call. 

As an alternative, in general available Feature Access Codes (FACs) for call management 
work during calls, for instance *55 for direct transfer to voice mail, but the ongoing call 
must be put on hold and a new call must be made to the FAC ”number”.  Using DTMF for 
the same purpose does not work. 

When establishing a call to a contact, you can choose several ways to call.  Right-click the 
contact you want to call and select the Call menu item.  You can choose the number to 
call from a right-click menu.  There can be several phone numbers available in the menu.  
The work phone is the default and top most number is followed by mobile and other 
numbers.  This also applies to the transfer and conference windows.  However, in certain 
cases, the transfer/conference default number can differ from other call options in other 
menus. 

The default call type can also be selected using accessibility menus (Calls → Dialing 
service).  This controls the default call type when using call buttons. 

Dial a number in the combined Search and Dial field to make a call.  Once you type your 
numbers, Communicator searches for contacts on both the local contact list and the 
enterprise directory. 
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Choose your video size from the Preferences and the Video tab.  Your selection is used 
by default for future video calls.  The available sizes are automatically presented based on 
your camera. 

You cannot have two simultaneous calls with the same person. 

Communicator does not add video to an audio call without end-user consent.  This also 
applies to blind video call transfer cases where audio-only music on hold is used; this may 
result in the transferred call being reduced to audio. 

6.1 Call From Computer 
Select a contact from your contact list to start communication and click the desired 
communication button.  To communicate with someone who is not on your contact list, 
type a phone number in the Search and Dial field at the top of Communicator window 
(search or communicate). 

6.2 Call From Phone 
The second option to communicate in the row of communication buttons is the Call from 
Phone.  When you click this button, the desk phone instantly starts ringing and the call is 
established from your desk phone.   

Automatic Busy – In Call presence also works with the Call from Phone feature. 

6.3 Answer Call 
When someone is calling you, you see a pop-up notification on your screen.  You can 
choose to answer or decline the incoming call.  If you decline the call, the ringtone is 
silenced but the caller does not see anything on their end.  The call will continue to ring on 
other devices (eg: your Desk phone). 

When someone is calling you with a video, you see the same pop-up notification; 
however, the options are answer with video, answer as voice only, or decline.  If you 
decide to answer as voice only, the call is voice only. 

6.4 Contact Name Lookup for Incoming Calls 
Communicator performs a local contact search for incoming calls.  If the number matches 
one of the contacts on the Communicator contact list, the name is shown on the incoming 
call screen along with the alert.  Both the display name and phone number are shown 
when available. 

If there is no match to a local contact, Communicator looks for a match in the Telephony 
Directory and other available directories, and if a match is found, the available information 
is shown for the incoming call.  If there is no match in the Telephony Directory, the display 
name is taken from the available information in the incoming call. 

Whenever you retrieve your call logs/history, Communicator does a lookup in the local 
contacts and populates the name if a match is found. 

6.5 Missed Call or Communication 
When you have one or more missed calls or other types of communications, there is a 
notification on the left-hand side of the navigation pane in the Main window.  Clicking the 
icon takes you to the missed communication in the Communications History view. 

6.6 Full Screen in Video Call 
Full screen mode can be activated by clicking the Full Screen button or by double-clicking 
anywhere on a video. 

https://primus.ca/


 

PRIMUS UC COMMUNICATOR DESKTOP USER GUIDE R22.5.0 
©2018 FUSION. ALL RIGHTS RESERVED.    PAGE 21 

Exiting full screen mode is done by pressing the Esc key (on both Windows and OS X) or 
by double-clicking the window.  Exiting full screen makes the video call go back to its 
original state (even if there was resizing of the window previously before going full screen). 

In a full-size window, you can see a similar Options menu at the top.  It has the same 
functionality as it does in the normal view.  When you move the mouse, the top bar and 
lower communication buttons appear on top of the video. 

6.7 Multiparty Sessions 
You can have many participants in a call, either in a My Room or in an ad hoc multiparty 
call.  Add more participants by dragging and dropping them on to the Communications 
window or by selecting the Conference menu item via the Communications window menu 
button.  By choosing the menu item, you can also add participants with just a telephone 
number.  Ad hoc multiparty calling is slightly different in that each call party must be 
separately merged onto the call to be able to terminate failing calls to, for example, voice 
mail. 

In contrast to using My Room, which uses your permanent chat and collaboration rooms 
and conference bridge, you can start ad hoc multiparty sessions by either selecting 
multiple contacts on the contact list and starting a chat, by calling them, or by expanding a 
one-to-one session into a multiparty session by dragging and dropping a contact into the 
Communications window.  In an ad hoc session, the room used is a temporary one that is 
deleted once the session ends (that is, when the last participant leaves).  Voice 
conferencing does not use a bridge but instead uses the 3-Way Calling supplementary 
service in a sequential fashion.  Communicator dials out to all participants and takes 
everyone off hold after the last attendee answers. 

6.8 Call Waiting 
You can have one active call at any one time if you receive a new incoming call and 
accept it.  The existing call is put on hold and you can change between these two calls by 
using the Hold and Unhold buttons. 

6.9 Call Transfer 
Blind call transfer is available in the Communications window; choose the Transfer Call 
menu item to transfer the call to someone else. Attended call transfer is also available in 
the same window, first call someone to check if the called party can take the incoming call 
and then transfer the incoming call to the desired called party.  You can also search for the 
transferred-to party. 

6.10 Message Waiting Indication and Visual Voice Mail (Preview) 
You have the ability to view your Voice Mail in the client. 

The Message Waiting Indication shows you there is a waiting voice mail or video mail by 
incrementing the number of the missed calls badge on the Call History icon.  By clicking 
on the Call History icon you will be able to toggle between your call history and your 
voicemails. 

When you listen to the voice mail or marking it as read decreases the missed calls badge 
while just doing a single click does not. 

6.11 Call Park and Retrieve 
Call Park is particularly suited for shared environments where one person can answer the 
call, park it, do something else for a while and continue the call from another device or let 
somebody else continue the call. 
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An ongoing call can be parked against your own number or another number (an 
extension).  Call Retrieval works in the same way, the parked call can be retrieved from 
your own number (an extension) or another number (an extension) to provide flexibility for 
who is picking up the parked call. 

A parked call is visible on your desktop in the Active Communications area so that you can 
easily retrieve it, but only for the duration of the Call Park announcement.  After the 
announcement is over, the parked call disappears from the Active Communications area 
(since the triggering call is disconnected).  After the call disappears from the Active 
Communications area, the user must remember the extension to which the call has been 
parked to retrieve it using the Main window menu (or feature access code), unless the call 
was parked to the one’s “own” extension.  If the call is not retrieved after a certain time, 
then the server calls the parking user. 

6.12 Call Pull 
Call Pull allows you to pull an ongoing call from one of your devices to another one where 
the Call Pull feature is used.  Call Pull can also be used with FACs, in this case, *11.  User 
interface support has been added to the Desktop so that an end user does not have to 
remember FACs. 

6.13 Moderator Controls 
You can control the functionality available to participants if you are the owner of the 
session in My Room.  You can do the following: 

 Dismiss one or more participants.  This ends all sessions (group chat, audio, video, 
and share) when the participant is using Communicator for Desktop. 

 Mute one or more participants. 

 See active talker indication. 

 See full participant list. 

 Allow or disallow participants to share their screen. 

To invoke the features, you can use the right-click menus or you can click on the 
moderator control icons of a participant.  Note that most features are not available via 
icons.  To dismiss or mute all participants, use the right-click menus available for your own 
icon at the top of the participant list. 

6.14 Forced Logout 
You may see a pop-up saying that you have been logged out due to another instance of 
the client logging in.  Primus UC tracks similar online client instances and only allow one of 
them to be online at the same time.  When the client logs out, all connections are 
terminated and client returns to the login window. 

6.15 Presence Rules and Silent Alerting 
You can combine call processing with presence statuses.  For instance, the “Busy” status 
can be combined with Call Forwarding so that when the “Busy” presence status is used, 
calls are forwarded.  It does not matter how the presence status is invoked, via automation 
or manually. 

All presence statuses can have presence rules: 

 Available 

 Busy 
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 Away 

 Offline 

The following call processing services can be used: 

 Silent alerting 

 Call forwarding to number 

 No rules 

If presence rules are used, all your client devices should have this service enabled to 
avoid side effects.  Silent alerting can only be enabled via presence rules in 
Communicator. 

https://primus.ca/


 

PRIMUS UC COMMUNICATOR DESKTOP USER GUIDE R22.5.0 
©2018 FUSION. ALL RIGHTS RESERVED.    PAGE 24 

7 Application or Desktop Share 

To share your desktop or individual application: 

1) In the Communications tab, click the Start Share button.  This does not yet start the 
“share”. 

2) Select either to share your entire display or one of your open applications and click 
Start Sharing. 

The share widget appears to let you control share settings such as Preview that 
shows you what participants are seeing and Pause that pauses sharing. 

3) To stop sharing, click the Stop icon.  While sharing, all other communications 
mechanisms are also available except for video calling and file transfer.  Participants 
cannot hide a share without closing the Communications window.  Video call is also 
available while sharing. 

For participants without Communicator, use the separate Desktop Share Invitation link by 
right-clicking the My Room button.  Share selector is not dynamically updated while the 
selector is open and minimized applications are not available in the list of applications to 
share. 

If you are first in a video call and then start share, your own video is not shown due to 
limited space available, but you can make it visible using the Main window menu in the 
bottom right-hand corner by selecting “Show Own Video”. 

If you are using dual monitors, you can choose which monitor to share.  You can check 
the primary monitor in the operating system settings. 

You can also remove desktop share participants.  They are also removed from the group 
chat at the same time.  If needed, the removed participants can join later. 

In addition, participants can share by clicking on the Share button; however, the room 
owner can prevent this at any time.  Only one person can share at any one time in a 
session.  Only one share at a time is supported if you have sessions with many users at 
the same time.   

Participants do not have to take any action to accept the share invitation.  It is 
automatically accepted.  The owner does not have to take action for the participant to start 
sharing. 

When video and share are used at the same time, the different views cannot be resized.  
Instead, the primary view can be selected from the bottom of the window via thumbnails. 
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8 My Room 

My Room is started by clicking on the My Room icon on the top right-hand side of the 
Main window.  My Room is started automatically using your permanent chat room.  Add 
more participants by dragging and dropping them into the Communications tab or the 
Conference menu.  Otherwise, they can join your room by right-clicking your name on their 
contact list and choosing the Join Room menu option.  Once people have joined the chat 
room, they can click on the Call button of that window to join the conference.  The room 
owner can also share their desktop. 

In addition to the owner of the room, participants can also share the desktop. 

1) To see a Context menu, right-click the Options icon (three dots) on the right-hand 
side of the My Room tab for Room Info. 

2) Select Copy Guest Link to copy an invitation link to the operating system clipboard.  
Paste this link, for instance, to a meeting invitation email to allow Communicator 
participants to join the conference in one click from, for example, Outlook, or Office 
applications.  Note that some applications may not recognize the Communicator 
(btbc:)  link.  You can also copy the My Room Invitation to the default email client (this 
text does not contain the Communicator link) and go to the My Room preferences via 
a right-click menu option. 

The link has two parts:  one for Communicator users and another one for users with 
some other client.   The invitation always contains a dial-in number and PIN for users 
who do not have Communicator.  The desktop share link, when available, allows 
anyone to join a desktop share session from a standard web browser.  In addition, the 
Communicator group chat session is supported with the web collaboration session.  
For guest user links, see the next section. 

The My Room info area indicates the conference bridge details of your My Room.  
You can also copy the attendee list to the clipboard using the related participant menu 
available via the options icon (three dots). 

The Communications window also has an icon that provides the same Context menu 
previously discussed. 

For more information on desktop sharing, see section 7 Application or Desktop Share.   

My Room uses your permanent chat room, permanent collaboration room, and 
conference bridge (audio or video).  My Room is the only way to use the permanent 
rooms.  Any other multiparty communications, such as selecting multiple contacts, and 
right-clicking for a conference call, or dragging and dropping for a one-to-one chat, is done 
using ad hoc rooms.  Ad hoc rooms are deleted once the session is over. 

All My Room sessions start as chats but call and/or share can be added to the session 
while in progress.  File transfer and video conferencing are not supported in My Room or 
ad hoc sessions. 

8.1 Guest Client 
The guest client allows those external to your organization, or those in your organization 
who do not have Primus UC, to join a full My Room session with a web browser 

You can generate separate invitations for guest users using My Room right-click menu 
items as described in the previous section.  My Room invitations are generated using 
separate menu items and are intended for Communicator users. 
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Guest users can join a session with audio in the web browser by using the provided dial-in 
number and conference PIN as well as use group chat and sharing inside the web 
browser.  However, guest clients do not have private chat possibility and they can only see 
the chat history of messages that occurred after they joined the session. 

The invitations persist until reset via a separate right-click menu item.  The My Room 
owner must individually accept each joining guest participant.  Not doing this in a 
predefined period of time results in the invitation becoming obsolete and guests not being 
able to use the link to join. 

After dismissing a guest user from share and chat, the audio/video portion can remain. 

The following OS and browser combinations are supported if WebRTC is enabled by your 
service provider: 

 Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 
[Classic]) and OS X (10.8, 10.9, and 10.10) 

For more information on guest client usage, see Appendix B:  Guest Client Usage. 
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9 Search 

Communicator supports a search of the enterprise directory as well as the personal 
directory, enterprise common directory, and group common directory.  This takes place in 
the same Search field that is used for both a local and presence-enabled contact list 
search.  The various directories have different purposes with the enterprise directory 
having the most data, and not all directories may be used in all deployments.  All search 
results are combined into one common set of results. 

Personal directory, enterprise common, and group common directories cannot be 
modified from the client side.  Only read access is provided.  A snapshot of the presence 
status of the contact in the results list is shown, but this presence is not updated after the 
search operation. 

Communicator automatically searches the local contacts and presence-enabled contact 
list in addition to the enterprise and other directories at the same time.  As soon as there 
are results from the enterprise and other directories, these results are shown on a 
separate list in the Main window.  Additionally, there may be other search result groups 
from Outlook. 

Search results are displayed differently depending on the results of the contact list and 
directory search: 

 If Outlook search is enabled, there are more result groups. 

 If there are no results for a certain search source (for example, local contacts, 
Outlook, orTelephony Directory), then that group is not shown. 

The enterprise directory searches all available fields for the search string.  By default, it 
waits for 1.5 seconds before it sends the search request to the server to minimize 
unnecessary load on the server. 

The phone number is displayed in the search results to better distinguish similar search 
results.  In addition, ToolTips are provided for search results. 

Typically, when adding a contact using directory search results, there are phone numbers 
and first names in addition to last names available.   

Outlook integration (search and calendar integration) on Windows requires one of the 
following versions installed on the desktop: 

 Outlook 2010 

 Outlook 2013 

 Outlook 2016 

Outlook search also works when several Outlook accounts are in use, but only one 
account is used at a time (default selected, which can be changed in Outlook).  
Additionally, other related considerations are as follows: 

 The client searches for contacts and calendar entries in the default Outlook account.  
The account is set to the default via File → Info (left pane) → Account Settings → 
Account Settings → Data Files.  Select an account and mark it as “Set as Default”.  
After making this change, sign out and sign back in to the client and it now searches 
that account for contacts and calendar entries. 

 The client searches the Outlook contacts only on the local machine (that is, the 
Outlook Address Book).  There is no Exchange server lookup performed.  In addition, 
all directories in Outlook are searched for contacts, even deleted folders.  The 
Contacts directory can also have multiple levels of subfolders. 
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Every minute, Communicator reads Outlook appointments.  If there is an appointment 
running at the current time, then the presence is shown as Busy – In Meeting.  
Overlapping appointments are also handled.  Following are some examples of 
Communicator operation with Outlook when time is 9:10 A.M. 

 There is meeting “A” 9 A.M. through 10 A.M.  Presence is shown as Busy – In 
Meeting. 

 Presence is explicitly changed to Available at 9:15 A.M.  Presence is shown as 
Available. 

 In the next minute, Communicator again reads the appointments and sees that “A” 
meeting is running; however, the presence was already explicitly marked as Available 
and presence is not shown as Busy – In Meeting but Available. 

 There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M.  Presence is 
shown as Busy – In Meeting when the time is 9:30 A.M. 

When deleting a meeting that is currently ongoing in Outlook, the presence status remains 
as Busy – In Meeting until the next time Outlook appointments are checked (once every 
minute) and after that, presence is shown as Available.  This change may be 
instantaneous or it may take a minute depending on how close the timer is to being 
triggered. 

The presence update is only triggered by appointments and meetings that are either 
accepted by the user or made by them.  All day meetings do not trigger a presence 
change to Busy – In Meeting. 
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10 Full Enterprise Directory 

Communicator allows for browsing of an entire enterprise directory. 

To view the full enterprise directory, click the Directory button on the left-hand side of the 
navigation pane. 
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11 Communications History 

In the Main window on the left-hand side of the navigation pane you can access views that 
display your messaging history.  The History view is divided into two tabs: 

 Chat 

 Calls (which includes a view into your voicemail) 

Double-clicking a conversation on the chat tab list opens it in a new window while double-
clicking a call history item calls that number.  Clicking a visual voice mail downloads the 
message so you can play it. 

Communicator saves a call history for placed, received, and missed calls.  The call history 
makes it easy for you to redial and call back when you have missed a call or you want to 
easily dial a contact with whom you have recently spoken.  Each call has a separate entry 
in the list. 

Chat history for group chats, both in My Room and in instant group chat, are stored locally 
on the Desktop client, just like in one-to-one chat, but only for the time the user is joined 
into the session.  Look at individual chats by double-clicking the contact in the contact list 
or click the chat history icon in the left pane. 

Double-click on a name in the list to call back directly (this calls back the same way you 
previously spoke, for example, if you were in a video call, double-clicking starts a new 
video call).  Double-clicking an incoming call item in the Calls tab makes a call. 

To clear the missed chat indicator, you must open the missed chat. 

The Communication History missed communications badges can be cleared by using the 
right-click menu from the Communication History button on the left pane.  The menu 
provides options to mark “All as viewed”, “Chats as viewed”, “Voicemails as viewed”, and 
“Calls as viewed”. 
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12 Outlook Add-in 

12.1 Introduction 
The Outlook Add-in for Communicator provides integration between Communicator 
Desktop and Microsoft Outlook. 

With this add-in, you can have Microsoft Outlook display Communicator contact presence 
and invoke Communicator functions like chat, call from computer, call from phone, and 
video call from within Outlook. 

12.2 Supported Platforms 
The following platforms are supported: 

 Microsoft Outlook 2010 (32 and 64-bit), Microsoft Outlook 2013 (32 and 64-bit), and 
Microsoft Outlook 2016 (32 and 64-bit) 

 Microsoft Windows 7 SP1, Microsoft Windows 8, Microsoft Windows 8.1, and 
Microsoft Windows 10 

NOTE:  The Outlook add-in cannot be used if you have Microsoft Office Communicator or Skype 
installed.  You must uninstall these products if you want to use this add-in.  Skype for Business 
may be used at the same time but is not supported by the Outlook Add-in. 

Additionally, administrator rights may be required for the Outlook Add-in. 

The following language and locale combinations are supported in the installer and the 
add-in: 

 English 

 French (Canada) 

The following third-party components must be installed for the add-in to function correctly: 

 Microsoft .NET Framework 4 Client Profile 

 Microsoft Visual Studio Tools for Office (VSTO) 2010 Runtime 

These components are downloaded and installed by the installer if they are not found.  
They should not be uninstalled, as the add-in cannot functional correctly.  Additionally, for 
Outlook 2016 and the Outlook Add-in (OL2016 Add-in), there are further considerations as 
follows: 

 The Outlook Add-in may need to be installed by an administrator. 

 If an administrator installs for all users and a normal user starts using the OL2016 
Add-in, Communicator needs to start before Outlook. 

 For logging to work normally, Communicator needs to start before Outlook. 

 Every logging level change requires a restart of both Communicator and Outlook for 
changes to take effect.  This should be quite rarely needed. 

 If Outlook is closed while Communicator is running, Communicator needs to be 
restarted as well for the Outlook UI to behave as expected. 

 Communicator lists connected components as extensions, if connected is NO or if 
component version number is something other than 10.2.1.29, or both presence GW 
and add-in are not listed, an error has occurred.  Component is visible under Options 
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→ Add-ins → UI, which displays registered and working add-ins on top, below 
stopped or non-working ones. 

 If both are listed and show connected is YES, but the Outlook UI does not work, 
restart both apps. 

 For Outlook upgrade requirements, see section 12.5 Installation. 

NOTE:  Communicator must be installed with administrator privileges in C:\Program Files OR the 
C:\Program Files (x86) folder. 

12.3 Log Files 
Log files for the Add-in are located in the Communicator log directory.  You can open the 
folder via Preferences → Advanced by clicking on the Show logs button.  Outlook Add-in 
logging is turned on when Communicator logging is enabled. 

12.4 Windows Registry Entries 
The following table lists all the registry entries added or modified by the installer. 

Path Key Comment 

HKEY_CURRENT_USER\Software\Bro
adSoft\Communicator\OutlookPlugin\o
lwnd 

wnd Keeps Outlook applications 
window reference. 

HKEY_CURRENT_USER\Software\Bro
adSoft\OutlookPlugin 

LoggingLevel Logging level for Outlook 
plugin components.  Its value 
as per Communicator Options 
→ Advanced logging selection 
as follows: 
Basic logging on:  0x00000003 
Detailed logging on:  
0x00000005 
Both off:  0x00000000 

HKEY_CURRENT_USER\Software\Bro
adSoft\InstalledBrandedBTBC 
Can also exist in 
HKEY_LOCAL_MACHINE (even under 
Wow6432Node). 

Example, 
OutlookPluginPath, 
CompanyName, 
ProductName 

These keys affect where the 
plugin is searched for when 
starting and where log files are 
written. 

HKEY_LOCAL_MACHINE\Software\Mic
rosoft\Office\Outlook\Addins\Commun
icator Add-in for Outlook 

LoadBehavior 0x00000003, based on this 
value Outlook loads the add-in 
dll. 

HKEY_LOCAL_MACHINE\Software\Mic
rosoft\Office\Outlook\Addins\Commun
icator Add-in for Outlook 

Description Communicator Add-in for 
Outlook. 

HKEY_LOCAL_MACHINE\Software\Mic
rosoft\Office\Outlook\Addins\Commun
icator Add-in for Outlook 

FriendlyName Communicator Add-in. 

HKEY_LOCAL_MACHINE\Software\Mic
rosoft\Office\Outlook\Addins\Commun
icator Add-in for Outlook 

Manifest $INSTDIR\plugins\Outlook$nO
utlookBitness\UC-Outlook-
addin.vsto|vstolocal 

HKEY_CURRENT_USER\Software\IM 
Providers 

DefaultIMApp Communicator 

HKEY_CURRENT_USER\Software\IM 
Providers\Communicator 

UpAndRunning 0x00000002 
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HKEY_LOCAL_MACHINE\SOFTWARE\
IM Providers\Communicator 

FriendlyName BroadsoftIMApp 

HKEY_LOCAL_MACHINE\SOFTWARE\
IM Providers\Communicator 

GUID {E3D1613A-93B2-4237-B4B8-
B50595462C25} 

HKEY_LOCAL_MACHINE\SOFTWARE\
IM Providers\Communicator 

ProcessName presencegw.exe 

HKCU\Software\IM 
Providers\DefaultIMApp 

UC-One Application 
name 

Needs to be taken by 
Communicator to be able to 
call, call for example, PSTN 
numbers from Outlook. 

 

12.5 Installation 
The Outlook Add-in installation is integrated with the Communicator installation.  There is 
a check box in the installer to enable the Outlook Add-in installation.  If Outlook is 
upgraded, the Outlook Add-in must be re-installed, since the Add-in uses different files 
depending on the Outlook version. 

The Outlook Add-in installation requires administrator rights to the computer for all Outlook 
versions. 

12.6 Features 

12.6.1 Presence in Outlook 

The Outlook Add-in displays the presence of a contact in Outlook.  Presence information 
is retrieved from Communicator and is displayed as an icon next to the contact in emails 
and calendar appointments.  The following is an example of an email with the To, From, 
and Cc fields showing presence for various contacts. 

 
Figure 2  Presence Displayed in Outlook 

A contact’s presence can be Available, Away, Busy, or Offline as shown in the following 
figure. 

 
Figure 3  Presence Values 
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NOTE:  You must be signed in to Communicator for the presence to be displayed.  Additionally, 
presence is only shown for contacts that have a valid SIP address and are in your contacts list in 
Communicator. 

12.6.2 Contact Actions in Outlook 

Right-click on an email in your Inbox and call or chat with the sender using Communicator.  
You have the option to Chat, Call (from Computer), Call from Phone, or Video Call as 
shown in the following figure. 

 
Figure 4  Contact Options 

NOTE:  Some of these options may not be available for all contacts.  The chat option is only 
applicable to contacts that are in Communicator.  Call options are applicable to all contacts as 
long as they have a valid phone number. 
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These contact actions are also available on a contact card as shown in the following 
figure. 

 
Figure 5  Contact Card 

 

12.6.3 Call Multiple Phone Numbers Configured for Communicator / Non-Communicator 
Contacts 

You can call any of the multiple phone numbers present in the Outlook contact card.  This 
feature is available from received mail context menu, flagged mail context menu, and 
Contact’s context menu.  You can also call the selected phone number via Call, Call from 
Phone, and Video Call. 

However, you cannot call multiple numbers for contacts stored on the Primus UC client; 
only numbers stored in Outlook. 
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See the following figure for an example of how to make the call from a received mail 
context menu. 

 
Figure 6  Received Mail Context Menu in Outlook 

See the following figure for an example of how to make the call from the contact item 
context menu. 

 
Figure 7  Contact Item Context Menu in Outlook 

 

12.7 Uninstall Outlook Add-in for Communicator 
Uninstallation is done together with uninstallation of Communicator. 
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12.8 End-User Configuration 

12.8.1 SIP Address in Microsoft Outlook Contacts 

NOTE:  This section is only applicable if you use Microsoft Exchange with Outlook.  You do not 
need to configure the SIP address for SMTP-based accounts (for example, Google Mail). 

In order for the Outlook Add-in to integrate with Communicator, you must set a SIP 
address for each contact.  The SIP address for a contact in Outlook must match the SIP 
URI, Instant Messaging and Presence (IM&P) address, or Email field in Communicator.  
This is usually done by your Microsoft Exchange administrator. 

You can check if a SIP address has been configured for contacts by looking at the Outlook 
properties for a contact.  In Outlook 2010, open a contact card and then click on the View 
more options button as shown in the following figure. 

 
Figure 8  Outlook Contact Properties 
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Then select the Email Addresses tab.  It should have a SIP address in the list of Email 
Addresses as shown in the following figure. 

 
Figure 9  SIP Address for Outlook Contact 

If the SIP address is missing, you can try to update the Address Book from the server as 
shown in the following figure. 

 
Figure 10  Download Address Book 

Additionally, when adding contacts from Outlook to Communicator, the IM address field 
can be populated in Outlook so that the presence feature can work directly on the 
Communicator side as the information is imported to the Communicator contact card. 
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13 Accessibility Compliance 

Communicator supports accessibility compliance by having all client features available in 
menus at the top of the Main window.  The menu items are also available using the 
keyboard shortcuts listed in Appendix A:  Keyboard Shortcuts for Desktop. 

The application also has support for the following features: 

 Dictation 

 Screen reader (VoiceOver on OS X) 

 Keyboard navigation 

The following limitations apply: 

 On OS X by default, the tab key moves the focus between text-inputs and lists.  This 
can be changed through System Preferences → Keyboard → Shortcuts.  Under Full 
Keyboard Access, select “All Controls” instead of “Text boxes and lists only”. 

 Dictation on OS X:  If WebRoot SecureAnywhere is used, Pause Secure Keyboard 
Entry must be selected. 

 User must manually select the correct language in screen reader.  Primus UC does 
not force screen reader's language according to the language selection in the client. 

 On OS X, the VoiceOver focus follows the VoiceOver Cursor.  When VoiceOver is 
enabled, user is expected to navigate with the VoiceOver Cursor.  That can be 
enabled through System Preferences → Accessibility → VoiceOver → Open 
VoiceOver Utility.  In the opened window, open “Navigation” and check “Keyboard 
focus follows VoiceOver cursor”. 

 When using VoiceOver on OS X with diffrerent languages, the OS language, cleint 
language, and VoiceOver language all need to be the same. 

Recommended Preferences → General → Accessibility settings for screen 
reader/VoiceOver are: 

 ToolTips disabled 

 Pop-up errors enabled 
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14 Google Analytics 

Primus UC Communicator can send analytics data to improve the service.  You can 
enable and disable this option in Preferences. 
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15 Preferences 

Preferences provide access to available settings for Communicator.  Follow these steps to 
access Preferences. 

Windows and OS X 
1) Click the Preferences logo in the Main window left pane. 

2) Select the desired view from the drop-down. 

or 

Windows and OS X 
1) Go to the File menu in the upper left. 

2) Select Preferences. 

3) Select the desired view from the drop-down. 

15.1 General 

Language 
Select your language then click OK or Apply and the change takes effect immediately. 

Login 
Enable or disable automatic login when starting the application and control the remember 
password feature. 

Notifications 
Usually there is a confirmation pop-up notification each time you remove a contact or chat 
history record.  By selecting one or all of the check boxes, you can disable the 
confirmations when deleting information.  You can also control whether there is always a 
pop-up notification for publishing location information.  Typically, this is shown at login.  
You can also select whether to receive a notification before ending communication or 
holding a call. 

Accessibility 
Enable pop-up errors allows Communicator error pop-ups to be shown in addition to the 
usual error text shown at the top of the Main window. 

Enable ToolTips is enabled by default.  For accessibility, screen reader/VoiceOver reads 
all ToolTips, which may be frequent and hence disturbing.  For this reason in accessibility 
cases, it is recommended to disable ToolTips. 

You can also enable spell checking. 

15.2 Audio/Video 

15.2.1 Audio 

Headset 
Here you can specify what are the output and input devices used for the headset when 
toggling between the headset and speakers. 
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Output Device (Voice Playback) 
Choose a headset, PC-integrated speakers, or external speakers for audio output.  Your 
external playback device is selected by default (if you have one connected). 

Input Device (Voice Recording) 
Choose a headset microphone, PC-integrated microphone, or external microphone for 
voice during calls.  Your external recording device is selected by default (if you have one 
connected). 

Speakers 

Here you can specify what are the output and input devices used for speakers when 
toggling between the headset and speakers. 

Output Device (Voice Playback) 
Choose a headset, PC-integrated speakers, or external speakers for audio output.  Your 
external playback device is selected by default (if you have one connected). 

Input Device (Voice Recording) 
Choose a headset microphone, PC-integrated microphone, or external microphone for 
voice during calls.  Your external recording device is selected by default (if you have one 
connected).  

Ring Device (Alert Signal) 
Select the audio device that is played when you receive an incoming call. 

Ring Signal 
You can select your own ring signal.  The same signal is used for both voice and video 
calls. 

You can also select an icon to play a tone for incoming messages.  To disable the tone, 
uncheck the icon.  

15.2.2 Video 

Capture Device (Video) 
Select a camera that you want to use for video calls.  Your external web cam is selected 
by default (if you have one connected). 

Video Size 
Select one of the available sizes.  Note, however, that higher sizes require more 
bandwidth and a more capable central processing unit (CPU). 

15.3 Incoming Calls 
For the list of available call management services for incoming calls, see section  
16 Call Settings. 

15.4 Outgoing Calls 
For the list of available call management services for outgoing calls, see section  
16 Call Settings. 
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15.5 Voice Mail 
You can specify various voice mail settings, such as which calls are sent to voice mail, 
what kinds of notifications you receive when voice mail arrives as well as controlling how 
fast the voice mail greeting is played and if callers are allowed to leave voice mails.  In 
addition, you can control how callers can end up going to voice mail. 

15.6 Services 
In this release, this section is reserved for presence rules and Hub settings.  For more 
information on presence rules, see section 6.15 Presence Rules and Silent Alerting. 

15.7 Extensions 
You can enable or disable access to Outlook Contact search and calendar. 

You can also manage extensions such as the Outlook Add-in or USB Device Add-In for 
compatible headsets which will allow such third-party applications to obtain information 
from Communicator.   

15.8 Advanced 

The Advanced view contains two different subsections: 
 Troubleshooting 

 Proxy 

Troubleshooting 
Logging is used for troubleshooting.  You may be asked by Primus support to turn on 
logging and then send the log file directory contents.  You can choose basic logging or 
more detailed logging to be enabled.  Detailed logging may consume memory resources 
so it is not recommended to have it enabled for a long period of time. 

You can also clear the logs and open the logging folder as well as enable and disable 
Google Analytics. 

Proxy 

Select how to handle HTTP proxies.  By default, the system settings are used but you can 
also choose not to use an HTTP proxy or to use the Communicator (client) proxy settings. 
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16 Call Settings 

Communicator supports the following service management features allowing 
supplementary services to be managed using the Preferences and Incoming Calls and 
Outgoing Calls view available in the Main window left pane by selecting the appropriate 
sub-view in the drop-down: 

 Incoming calls 

− Primus Anywhere 

− Remote Office 

− Forward Calls 

− Do Not Disturb 

− Simultaneous Ring 

− Anonymous Call Rejection 

− Call Waiting 

 Voicemail 

 Outgoing Calls 

− Block My Number (Calling Line Identification Blocking) 

− Automatic Callback 

− Highlight to call 

16.1 Primus Anywhere 
Primus Anywhere allows users to use fixed-mobile convergence (FMC) services without 
additional equipment. 

Primus Anywhere simplifies communications for on-the-go users and remote users by 
extending the features of a desk phone to any other fixed or mobile device, regardless of 
the network or handset manufacturer.  Callers dial one number and can reach you on any 
phone the user chooses.  A desk phone, cell phone, and/or a soft phone may ring 
simultaneously. 

Experience voice call continuity with the ability to move live calls from one device to 
another without hanging up. 

Add locations (numbers) that can be used in the service via the Add Number field.  Use 
the Alert all locations simultaneously check box to activate parallel ringing.  Click on the “+” 
icon to see more options. 

The Don’t divert check box prevents a call from ending up as a voice mail, which can be 
problematic in, for example, conference call situations. 

Select Answer Confirmation to receive a separate audio prompt when answering a call 
from that number (location).  It may be useful in cases where, for example, mobile 
numbers are being used to prevent incoming calls going to mobile voice mail since the call 
will be ended without going to voice mail if the answer confirmation is not provided. 

Select the Call Control check box to enable the server platform to provide mid-call 
services such as Call Transfer and Conferencing for that number (location). 
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16.2 Remote Office 
This service allows the use of any phone as the office phone from a numbering 
perspective.  For instance, a home phone can be used as the office phone. 

Enable Remote Office by clicking the service icon and specifying a phone number to be 
used as the Remote Office number. 

16.3 Forward Calls 
Enter a number to which your calls should be forwarded.  Different variants of Call 
Forwarding are supported, such as forwarding always, forwarding when busy, and 
forwarding when you cannot answer or when you are unreachable.  In addition, you can 
specify the number of rings before Call Forwarding is triggered. 

16.4 Do Not Disturb 
When you activate this service, all calls are typically blocked by the server and are sent to 
voice mail.  Enable this service by enabling the service icon. 

16.5 Hide Number 
You can hide or display your number when calling or communicating with other parties or 
contacts.  Hide your number by enabling the service icon.  To show your number, set this 
to “Disable”. 

16.6 Simultaneous Ring 
Add up to ten additional numbers that you would like to ring in addition to your primary 
number when you receive a call.  In addition, specify whether you want answer 
confirmations and if you would like to receive calls when already on another call.  This 
feature is an older variant of Primus Anywhere. 

16.7 Voicemail 
You can enable or disable voicemail in the Preferences and Voicemail tab.  A number of 
settings are available: 

 Send all calls to voice mail. 

 Send busy calls to voice mail. 

 Send unanswered calls to voice mail. 

 Specify how voice mail messages are handled using an indicator in Communicator or 
forwarding to email. 

 Enable notifications of new messages via email. 

 Email a carbon copy of new voice mail. 

 Transfer incoming calls to a specified number using “0” DTMF. 

 Specify how many rings are used before sending an incoming call to voice mail. 

 Allow/disallow callers to leave a message. 

16.8 Anonymous Call Rejection 
The Anonymous Call Rejection service allows you to reject calls from parties who have 
explicitly restricted their identities. 
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You can enable or disable Anonymous Call Rejection in the Preferences and Incoming 
Calls tab. 

16.9 Automatic Callback 
The Automatic Callback (ACB) service allows you to be notified when the previously called 
busy party becomes idle and is connected without having to redial the phone number. 

When you call another party and the call cannot be connected because the line is busy, 
you are prompted to make an Automatic Callback request (for example, “The line you are 
calling is busy.  Press 1 if you would like to be notified when the line becomes available”). 

If you select Automatic Callback, the system monitors the busy party and automatically 
establishes a call when the busy party becomes available. 

You can enable or disable Automatic Callback in the Preferences and Outgoing Calls tab. 

16.10 Call Waiting 
The Call Waiting service allows you to answer a call while already engaged in another call. 

You can enable or disable server-based Call Waiting in the Preferences and Incoming 
Calls tab.  If you disable Call Waiting, the second incoming call is not connected and the 
caller hears an announcement that the call cannot be completed or is sent to Voicemail. 
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17 Sign Out 

Signing out of Communicator sets your status to “Offline” for your contacts and displays 
the Sign In screen. 

17.1 Sign Out of Communicator 
To sign out, follow these steps. 

Windows 
1) Select File in the main menu. 

2) Select Sign Out (a keyboard shortcut can also be used). 

OS X 
1) Select Actions from the main menu. 

2) Select Sign Out (a keyboard shortcut can also be used). 

17.2 Exit Application 
To exit the application completely, follow these steps. 

Windows and OS X 
Close the Sign In window. 

Windows 
1) Select the File in the main menu. 

2) Click Exit (a keyboard shortcut can also be used). 

OS X 
1) Select Communicator from the main menu. 

2) Select Quit Communicator (a keyboard shortcut can also be used). 

NOTE:  Closing the Main window (not the Sign In window) does not exit the application but 
rather minimizes the application to the system tray (Dock).  This allows you to continue to 
receive calls and messages without having the Contact List window appearing on the desktop. 
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18 Multi-Device Support 

Communicator supports users with multiple devices with the Primus UC application 
installed (eg: Desktop, Mobile phone or Tablet).  This is comprised of several features: 

 Chat invitations sent to a user are received on all devices.  Once a particular device 
has been used to answer the chat invitation, subsequent incoming messages only go 
to that device. 

 One can retrieve one’s own presence notifications when another client updates the 
user’s presence.  The client stores this information and updates its own presence so 
that it is the same as the higher priority status it received, (that is, when the received 
status update is manual).  If the received presence update is not manual, it does not 
react to the received update; it only notes it. 

 Accepting a sharing presence invitation in one client is also recognized by another 
client, and both clients start receiving presence updates. 

 Last sent and received messages are available on all devices.  

 A new presence subscription made in one client is recognized in another.  If the 
contact declines the “invitation”, there are presence notifications from the server to all 
of the user’s clients indicating that the subscription was terminated and this 
information is shown to the user.  If the client receives two presence authorization 
requests from two or more devices for the same user, it only shows one request to the 
user. 

 Removing a contact from the contact list in one device is recognized in another client 
and the contact list is updated (that is, the contact is removed) in the other client as 
well. 

If a user has many devices, each device has the same status when shown to the end 
user.  In addition, the contacts on the contact list always see the same status with updates 
shown in the following priority order: 

 Busy 

 Online 

 Away 

 Offline 

This means, for example, that if one client publishes a Busy status and another client 
publishes another status, contacts see the user as Busy.  Compatible devices such as 
mobile phones with a Primus UC application are able to show presence in the same way. 

Communicator keeps track of its own presence status as well as the status of other 
devices and deducts the combined presence based on these.  For more information, see 
Appendix C:  Multi-Device Presence. 
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19 Installation 

The installer supports a number of options on Windows as follows: 

 Agree to the license agreement. 

 Run when system starts (can be changed later in Preferences). 

 Install Outlook Add-in. 

 Create a desktop icon. 

 Select destination folder for installation. 

 Select the name of the software in the Program menu. 

 Launch the client after installation. 

When installer has been run on an end user’s behalf by an administrator, the “Run 
program when system starts” option cannot be changed by that end user. 

If you disable startup, for example, in the Task Manager's Startup list (on Windows 8 and 
10) or from msconfig.exe on Windows 7, the change is not reflected in Preferences.  The 
check box remains checked and grey even though the client is not actually started 
automatically when the system starts. 

When Communicator is installed for the first time, you can choose the language.  The 
default language is the language of the operating system; if that cannot be found, English 
is used as the fallback. 

The Outlook Add-in installer is bundled together with the Communicator installer. 

History is specific to the application name.  If upgrading to another Communicator version 
that has a different application name, the history present in the other version is not 
available, so it is recommended to install with the default name. 
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20 Uninstallation 

The uninstallation procedure is different for Windows and OS X. 

20.1 Windows 
Uninstallation is performed by launching the Windows uninstaller via the Start menu or by 
using the Windows “Remove programs” view inside the Control Panel.  Windows 
uninstallation does not require you to select any options.  The language used for the 
Windows Start menu string “Uninstall” is taken from the language chosen when installing 
the client.  This string cannot be changed after installation. 

All files are deleted at uninstallation, except for the following files: 

 Registry entries 

 Account files are only deleted when explicitly allowed by the end user on Windows. 

20.2 OS X 
Uninstalling is performed by simply dragging the application folder from the Applications 
directory to the trash can; however, account files are not deleted.  If you want to remove 
account files, they must be manually deleted.  These are the file locations for the account 
directories which can be found in: 

/Users/<USERNAME>/Library/Application Support/Primus/UC Communicator 
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21 Version Control 

You may receive a notification to upgrade Communicator to a newer version.  This 
upgrade may take place automatically after you accept it in a separate dialog. 

The upgrade may be recommended or mandatory.  If it is mandatory, then Communicator 
does not start before the upgrade is done. 
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22 System Requirements 

System requirements are as follows on native Desktop: 

 Operating system:  Mac OS 10.10 Yosemite, Mac OS 10.11 El Capitan, Mac OS 
10.12 Sierra, Mac OS 10.13 High Sierra, Windows 7 SP1, Windows 8/8.1, or 
Windows 10 (Classical view only). 

 The installation footprint is approximately 125 megabytes (MB) on OS X and 215 MB 
on Windows. 

 For voice calls, a sound card, speakers, and a microphone or a headset are required. 

 For video calls, a web cam is required. 

Minimum system requirements for respective operating systems need to be fulfilled, with 
the following additions: 

 A minimum of 2 GB random access memory (RAM) is required. 

 A minimum 1.5 GHz CPU is recommended.  A dual core CPU is recommended for 
video calls at a minimum. 

 Open Graphics Library (OpenGL) 1.5 or higher is recommended. 

For high definition (HD) video, the following is recommended: 

 HD camera 

 HD resolution support in display 

 Quad Core x86 or equivalent at a minimum 

 4 GB RAM 

VDI environments are not supported. 
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23 Troubleshooting 

Why are my Emojis showing as black boxes? 
The Segoe UI font is required for the Emojis to appear correctly.  For more information to 
install the Segoe UI font, see the following article: 

https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-
applications-in-windows-7 

However, on Windows 7, some Emojis do not work despite this as listed in the following 
table. 

Emoji Number Code 

1 x1f600 

5 x1f615 

7 x1f61B 

9 x1f62E 

11 x1f61F 

15 x1F611 

17 x1F913 

18 x1F634 

19 x1F644 

20 x1F922 
 

Why did I lose chat history after an upgrade to a renamed Communicator? 
When installing a Communicator version that has a different application name, the history 
is specific to that application name.  If the application name remains the same in the 
upgrade, the previous history is available. 

Why can’t I change the avatar? 
Double-clicking the avatar should open a File Explorer view to select a file.  If your 
connection to Primus UC is temporarily lost, changing the avatar does not succeed.  A lost 
connection is indicated in the Main window’s top notification area. 

My contacts are all offline and my client’s status bar says “Chat unavailable”.  What 
does this mean? 
It means that the connectivity has been lost for chat, as well as for presence; however, you 
can still make calls.  This is typically a temporary condition that may be caused by a 
variety of factors.  If the situation persists, please contact your organization’s Hosted PBX 
administrative contact. 

Why am I offline? 
If you have selected “Offline” status, you are shown as offline to others.  Another possibility 
is that you may have lost your Internet connection.  In this case, the client does not log out, 
but rather enters an offline mode where a contact list is available but communication is not 
possible. 
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Why can’t I have more video resolutions available? 
You can choose your video resolution from Preferences and the Video tab.  Your selection 
is used by default for future video calls.  The available resolutions are automatically 
presented based on your camera. 

Why can’t I change my user name and password? 
User name and password editing is not supported in the client.  To edit your user name, 
contact your organization’s Hosted PBX administrative contact.  You can change your 
password via the online Hosted PBX portal at https://voice.primus.ca. 

Why does my all day calendar entry not trigger Busy – In Meeting presence status? 
Not all meetings trigger a presence change to Busy – In Meeting. 

To trigger the presence update, the meeting must be in the Show me as busy state. 

Why aren’t all my group chat messages saved? 
Only the newest chat room messages are stored on the server, but never for My Room for 
security reasons.  Messages sent from other devices are also shown. 

Why does my location show an incorrect address? 
It is done based on the public IP address that the machine is using.  The IP address is 
mapped to a physical location.  If you are using a VPN connection to a remote network 
this may affect the location displayed.  The mapping provider continuously looks to 
improve the accuracy of the location.  You can also manually change the location by 
clicking the avatar and changing the location icon. 

Why is the Outlook Add-in disabled? 

If the context menu does not show Add-in menu items, this could be due to the Outlook 
Add-in disabled by Outlook for slow loading.  This happens primarily in Outlook 2013.  In 
such cases, enable this add-in by selecting the Outlook menu → File → Info → Manage 
Add-Ins → Communication Add-in → Always enable this add-in from the displayed menu 
(as shown in the following figure). 

 
Figure 11  Outlook Account Information – Add-in Disabled 

https://primus.ca/
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Why is presence not showing in the Outlook Add-in? 

If the presence indicator icon is not shown in Outlook, verify any of the following software 
is installed: 

 Microsoft Office Communicator (OCS) 

 Microsoft Lync/S4B  

 Skype 

Uninstall each one found and restart Outlook and the Communicator client. 

NOTE:  During Office/Outlook 2013 installation, the installer installs Microsoft Lync by default.  
You must uncheck Microsoft Lync (as shown in the following figure) and then proceed with the 
installation. 

 
Figure 12  Microsoft Office Installation Example 

How do I disable/enable the Outlook Add-In from Communicator Preferences view? 

To enable/disable Outlook contact presence status (see section 4 Presence), from the 
Communicator Preference > Extensions page, the “Primus UC Communicator Outlook 
Add-in, Gateway process” check box option must be checked/unchecked. 

 
Figure 13  Communicator Preference Page 

To enable/disable the Outlook context menu related to the add-in, from the Communicator 
Preference > Extensions page, the “Primus UC Communicator Outlook Add-in” check box 
option must be checked/unchecked. 

 
Figure 14  Communicator Preference Page 
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Why are Outlook Add-in IM buttons sometimes are greyed out in the quick contact 
page, even though the user is logged in? 

Sometimes IM buttons are greyed out on the contact page.  When mouse over it, it shows 
the message “To use this feature, sign in to an instant messaging program". 

 
Figure 15  Outlook Add-in IM Buttons Issue 

This is an issue with Microsoft Outlook. The workaround to solve is to restart Outlook. 
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Appendix A:  Keyboard Shortcuts for Desktop 

The following table lists the currently supported keyboard shortcuts (native Desktop only).  
You can use these keyboard shortcuts to quickly perform frequently used actions.  The 
characters used are lower case.  The shortcuts are also indicated in the accessibility 
menus. 

Shortcut for 
Windows 

Shortcut for 
Mac 

What it does 

CTRL-Q Cmd-Q This quits the application. 

Alt+F4 Cmd-W This closes the selected window (except for a contact card and 
the About window). 

CTRL+C Cmd-C This copies selected text from Communicator to the clipboard. 

CTRL+V Cmd-V This pastes text from the clipboard to the location selected 
using the cursor in Communicator. 

CTRL-X Cmd-X This cuts the selected text to clipboard. 

Enter Enter When in the Communications window, this sends a chat 
message (if the Chat view is visible). 
When in the contact list, this opens a chat with the selected 
contact. 
When in the Communications History, this opens a 
communications session with the contact or address related to 
the selected item.  This opens a chat if the item was chat and a 
call if the item was a call. 

- Cmd-, This opens Preferences. 

F1 Cmd-? This opens Help. 

CTRL+A Cmd-A This selects all text in the Chat view. 

- Cmd-H This hides Communicator. 

- Alt-Cmd-H This hides other windows other than Communicator. 

CTRL-N Cmd-N This opens the Add Contact window. 

Shift-CTRL-N Shift-Cmd-N This opens the Add Group window. 

CTRL -1 Cmd-1 When a contact is selected, this opens a chat session with the 
contact. 

CTRL -2 Cmd-2 When a contact is selected, this calls the contact with audio. 

CTRL -3 Cmd-3 When a contact is selected, this calls the contact using call 
from phone. 

CTRL -4 Cmd-4 When a contact is selected, this calls the contact with video. 

CTRL -5 Cmd-5 When a contact is selected, this joins their room. 

CTRL -6 Cmd-6 When a contact is selected, this opens an email-sending 
window using the default email client. 

CTRL -I Cmd-I When a contact is selected, this opens the contact card for the 
contact. 

Shift-CTRL-F Shift-Cmd-F When a contact is selected, this makes the contact a favorite. 

CTRL-delete Cmd-delete This deletes the selected contact. 

CTRL-arrow 
down 

Cmd-arrow 
down 

This decreases the volume. 

CTRL-arrow 
up 

Cmd-arrow up This increases the volume. 
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CTRL-space CTRL-space This mutes the client (while in a call). 

CTRL-D Cmd-D This turns on the Do Not Disturb service. 

CTRL-P Cmd-P This pulls an ongoing call from your other device to 
Communicator. 

Alt-shift- 
CTRL-P 

Alt-shift-Cmd-P This retrieves your parked call. 

- Alt-Cmd-2 This calls your voice mail with audio. 

- Alt-Cmd-3 This calls your voice mail with audio using call from phone. 

- Alt-Cmd-4 This calls your voice mail with video. 

Shift-CTRL-R Shift-Cmd-R This opens your My Room. 

CTRL-M Cmd-M This minimizes the window on OS X.  On Windows, it only is 
used for the Team Telephony window. 

CTRL-T Cmd-T This enables always on top. 

- Shift-Cmd-M This opens the Main window. 

Shift-CTRL-C Shift-Cmd-C This opens contacts. 

Shift-CTRL-
F2 

Shift-Cmd-F2 This opens call history. 

Shift-CTRL-
F1 

Shift-Cmd-F1 This opens chat history. 

Shift-CTRL-
F3 

Shift-Cmd-F3 This opens visual voice mail. 

Shift-CTRL-D Shift-Cmd-D This opens the dial pad view. 

Shift-CTRL-W Shift-Cmd-W This opens the web button view. 
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Appendix B:  Guest Client Usage 

This section provides more hands-on information about guest client usage.  There is also 
a Primus UC My Room Guest Quick Reference Guide document that My Room owners 
may send to guest participants for their reference.  It can be downloaded from where all 
Primus UC documentation is found, at https://primus.ca/hpbxguide. 

  

1) Right-click on the My Room icon to copy the guest join link and send it to a guest via 
email or other means. 

 
Figure 16  Copy Guest Join Link Menu Option 

2) The guest can open the link in one of the supported browsers, enter their name and 
password, and then click JOIN ROOM. 

 
Figure 17  Login Screen for Join Room 

https://primus.ca/
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3) Once the guest clicks on JOIN ROOM, you can open your My Room and accept the 
guest request by clicking the green checkmark beside the pending request. 

 
Figure 18  My Room – Accept Guest Request 

You can also accept or decline join requests from the pop-up notification as shown in 
the following figure.  This pop-up notification is shown only if you already have your 
My Room open. 

 
Figure 19  Accept/Decline Request Pop-Up 

4) The guest is allowed into your room and can now participate in multi-user chat with 
other participants and access other functions, as highlighted in the figure below: 

 
Figure 20  My Room Window – Guest Chat 

The guest can join the audio/video portion of the session by clicking on the audio or 
video button.  This feature is only available on browsers that support WebRTC and 
the user must grant access to their camera and microphone by clicking Allow (as 
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shown in the following figure).  Primus recommends using the Google Chrome 
browser for best results. 

 
Figure 21  Allow Access to Camera and Microphone Access 

The guest can switch between audio and video mode by clicking on the video icon.  They 
can also mute and end the call by clicking on the mute and end call icons respectively. 

 
Figure 22  My Room Window Icons 

The guest can show or hide their self-view by clicking on the  icon in the top left 
corner of the video. 

The guest can also manually call the conference bridge directly by using the provided 
dial-in information. 

5) You can start your desktop share from the Desktop client and the guest then sees it.  
The video call is resized and moved to the top left. 

 
Figure 23  My Room – Desktop Share with Video Call 

https://primus.ca/
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Appendix C:  Multi-Device Presence 

This section provides a table describing the presence state changes based on the 
presence state that Communicator has as well as the presence status of other devices 
that the same user has active.  There is a distinction between what is shown in the UI and 
what is the internal presence status of the Communicator client since the design is to 
show the same own presence in the UI of all own online devices.  The following table 
describes presence state changes when steps 1 through 6 are executed in order, starting 
from step 1 and continuing through to step 6. 

 
 

The previous scenario happens when typing or mouse movement occurs on the desktop 
machine in steps 4 and 6.  If this is not done, then the away status would be the desktop’s 
“own” presence and the table would look as follows (same states in the beginning and 
different ones marked in green). 
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Appendix D:  Third-Party Software and Copyright 

The following third-party software is used in Communicator. 

 

Chromium 

Copyright (c) 2013 The Chromium Authors. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. * Redistributions in binary form must reproduce 
the above copyright notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. * Neither the name of 
Google Inc. nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS 
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

WebRTC 
Copyright (c) 2011, The WebRTC project authors.  All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

* Neither the name of Google nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission. 
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 

 

OpenH264 
Copyright (c) 2013, Cisco Systems.  All rights reserved. 

OpenH264 License:  https://github.com/cisco/openh264/blob/master/LICENSE 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 

 

Blowfish 
Based on a C implementation of the Blowfish algorithm by Paul Kocher 

UUID - RFC4412 

/* 

** Copyright (c) 1990 - 1993, 1996 Open Software Foundation, Inc. 

** Copyright (c) 1989 by Hewlett-Packard Company, Palo Alto, Ca. & 

** Digital Equipment Corporation, Maynard, Mass. 

** Copyright (c) 1998 Microsoft. 
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** To anyone who acknowledges that this file is provided "AS IS" without any express or 
implied warranty: permission to use, copy, modify, and distribute this file for any purpose is 
hereby granted without fee, provided that the above copyright notices and this notice 
appears in all source code copies, and that none of the names of Open Software 
Foundation, Inc., Hewlett-Packard Company, Microsoft, or Digital Equipment Corporation 
be used in advertising or publicity pertaining to distribution of the software without specific, 
written prior permission.  Neither Open Software Foundation, Inc., Hewlett-Packard 
Company, Microsoft, nor Digital Equipment Corporation make any representations about 
the suitability of this software for any purpose. 

*/ 

 

MD5 
Copyright (c) 1991-2, RSA Data Security, Inc. Created 1991.  All rights reserved. 

License to copy and use this software is granted provided that it is identified as the “RSA 
Data Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning or 
referencing this software or this function. 

License is also granted to make and use derivative works provided that such works are 
identified as “derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in 
all material mentioning or referencing the derived work. 

RSA Data Security, Inc. makes no representations concerning either the merchantability of 
this software or the suitability of this software for any particular purpose.  It is provided “as 
is” without express or implied warranty of any kind. 

 

SHA-1 
Copyright (c) The Internet Society (2001).  All Rights Reserved. 

This document and translations of it may be copied and furnished to others, and derivative 
works that comment on or otherwise explain it or assist in its implementation may be 
prepared, copied, published and distributed, in whole or in part, without restriction of any 
kind, provided that the above copyright notice and this paragraph are included on all such 
copies and derivative works.  However, this document itself may not be modified in any 
way, such as by removing the copyright notice or references to the Internet Society or 
other Internet organizations, except as needed for the purpose of developing Internet 
Standards in which case the procedures for copyrights defined in the Internet Standards 
process must be followed, or as required to translate it into languages other than English. 

The limited permissions granted above are perpetual and are not revoked by the Internet 
Society or its successors or assigns. 

This document and the information contained herein is provided on an “AS IS” basis and 
THE INTERNET SOCIETY AND THE INTERNET ENGINEERING TASK FORCE 
DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO ANY WARRANTY THAT THE USE OF THE INFORMATION HEREIN WILL 
NOT INFRINGE ANY RIGHTS OR ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

 

SQLCipher 

Copyright (c) 2008-2012 Zetetic LLC 

All rights reserved. 
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Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

* Neither the name of the ZETETIC LLC nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission. 

THIS SOFTWARE IS PROVIDED BY ZETETIC LLC ''AS IS'' AND ANY             
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ZETETIC LLC BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT             
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 

 

Lesser General Public License (LGPL) 
The following third-party libraries are in use based on LGPL license. 

This software uses Qt libraries licensed under the GNU Lesser General Public License 
(LGPL) 2.1. 

Qjson – Copyright 2012 – Flavio Castelli 

QXmpp – Copyright 2008-2011 The QXmpp developers 

QCA – Copyright 2003-2007 Justin Karneges justin@affinix.com.  Copyright 2004-2006 
Brad Hards bradh@frogmouth.net 

LGPL license are available at http://www.gnu.org/copyleft/lesser.html. 

LGPL license is also available locally with this software, at the installation directory. 

 

BSD license 
The following software is used based on BSD license: 

OpenSSL - Copyright 1998-2011.  The OpenSSL Project. 

License available at http://www.openssl.org/source/license.html. 

Breakpad - Copyright 1998, Regents of the University of California 

Breakpad license available at http://opensource.org/licenses/BSD-3-Clause. 

Stackwalker - Copyright 2009, Jochen Kalmbach 

License available at http://stackwalker.codeplex.com/license. 
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Apache license 2.0 
The following third-party libraries are using Apache license 2.0: 

Log4cxx - Copyright 2012 Apache Software Foundation. 

License available at http://logging.apache.org/log4cxx/license.html. 

 

Non-restrictive license 
The following third-party library is used based on its own non-restrictive license: 

OpenLDAP - Copyright 2013, OpenLDAP Foundation. 

OpenLDAP license is available online for review at 
http://www.openldap.org/software/release/license.html. 

OpenLDAP license is also available locally with this software at the installation directory. 

 

Free software 
The following free software is only used when third-party software is using the 
Communicator API via LGPL, MIT, BSD, or another license: 

Tufao (LGPL2.1) – Copyright 2012 Vinicius dos Santos Oliveira vini.ipsmaker@gmail.com 

Libcurl – Copyright 1996 - 2013, Daniel Stenberg, daniel@haxx.se 

License available at http://curl.haxx.se/docs/copyright.html. 

Tinythread++ - Copyright 2012 Marcus Geelnard 

License available at http://opensource.org/licenses/zlib-license.php. 

Picojson – Copyright 2009-2010 Cybozu Labs, Inc. Copyright 2011 Kazuho Oku 

License available at https://github.com/kazuho/picojson/blob/master/LICENSE. 

Easywsclient – Copyright 2012, 2013 dhbaird@gmail.com 

License available at https://github.com/dhbaird/easywsclient/blob/master/COPYING. 

The Qt Toolkit is Copyright (C) 2015 The Qt Company Ltd. 

Contact:  http://www.qt.io/licensing/ 

You may use, distribute and copy the Qt GUI Toolkit under the terms of GNU Lesser 
General Public License version 3. 

This license makes reference to version 3 of the GNU General Public License. 

LGPL license are available at http://www.gnu.org/copyleft/lesser.html. 
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Appendix E:  Acronyms and Abbreviations 

This section lists the acronyms and abbreviations found in this document.  The acronyms 
and abbreviations are listed in alphabetical order along with their meanings. 

ACB  Automatic Callback 

ACD  Automatic Call Distribution 

API   Application Programming Interface 

CPU  Central Processing Unit 

DND  Do Not Disturb 

DTMF  Dual-Tone Multi-Frequency 

EULA  End-User License Agreement 

FAC  Feature Access Code 

FAQ  Frequently Asked Question 

FMC  Fixed-mobile Convergence 

GUI   Graphical User Interface 

GW   Gateway 

HD   High Definition 

HID   Human Interface Device 

IM   Instant Message 

IM&P  Instant Messaging and Presence 

IP   Internet Protocol 

LGPL  Lesser General Public License 

MWI  Message Waiting Indication 

RAM  Random Access Memory 

SIP   Session Initiation Protocol 

UC   Unified Communications 

UI   User Interface 

URL  Uniform Resource Locator 

UVS  BroadWorks Video Server 

VDI   Virtual Desktop Infrastructure 

VoIP  Voice over IP 

WebRTC  Web Real-Time Communication 

XMPP  Extensible Messaging and Presence Protocol 

Xsi   Xtended Services Interface 

https://primus.ca/

	Table of Contents
	Table of Figures
	1 About Communicator for Desktop
	2 Get Started
	2.1 Installation
	2.2 Sign In
	2.3 Main Window
	2.4 Communications View
	2.5 Start Chat
	2.6 Send File
	2.7 Send Email
	2.8 Make Audio or Video Call
	2.9 Share Your Application or Desktop
	2.10 Active Communications
	2.11 My Room
	2.11.1 Select Audio Devices


	3 Contacts
	3.1 Add
	3.2 Edit
	3.3 Filters

	4 Presence
	5 Chat
	5.1 Chat View
	5.2 File Transfer

	6 Audio and Video Calls
	6.1 Call From Computer
	6.2 Call From Phone
	6.3 Answer Call
	6.4 Contact Name Lookup for Incoming Calls
	6.5 Missed Call or Communication
	6.6 Full Screen in Video Call
	6.7 Multiparty Sessions
	6.8 Call Waiting
	6.9 Call Transfer
	6.10 Message Waiting Indication and Visual Voice Mail (Preview)
	6.11 Call Park and Retrieve
	6.12 Call Pull
	6.13 Moderator Controls
	6.14 Forced Logout
	6.15 Presence Rules and Silent Alerting

	7 Application or Desktop Share
	8 My Room
	8.1 Guest Client

	9 Search
	10 Full Enterprise Directory
	11 Communications History
	12 Outlook Add-in
	12.1 Introduction
	12.2 Supported Platforms
	12.3 Log Files
	12.4 Windows Registry Entries
	12.5 Installation
	12.6 Features
	12.6.1 Presence in Outlook
	12.6.2 Contact Actions in Outlook
	12.6.3 Call Multiple Phone Numbers Configured for Communicator / Non-Communicator Contacts

	12.7 Uninstall Outlook Add-in for Communicator
	12.8 End-User Configuration
	12.8.1 SIP Address in Microsoft Outlook Contacts


	13 Accessibility Compliance
	14 Google Analytics
	15 Preferences
	15.1 General
	15.2 Audio/Video
	15.2.1 Audio
	15.2.2 Video

	15.3 Incoming Calls
	15.4 Outgoing Calls
	15.5 Voice Mail
	15.6 Services
	15.7 Extensions
	15.8 Advanced

	16 Call Settings
	16.1 Primus Anywhere
	16.2 Remote Office
	16.3 Forward Calls
	16.4 Do Not Disturb
	16.5 Hide Number
	16.6 Simultaneous Ring
	16.7 Voicemail
	16.8 Anonymous Call Rejection
	16.9 Automatic Callback
	16.10 Call Waiting

	17 Sign Out
	17.1 Sign Out of Communicator
	17.2 Exit Application

	18 Multi-Device Support
	19 Installation
	20 Uninstallation
	20.1 Windows
	20.2 OS X

	21 Version Control
	22 System Requirements
	23 Troubleshooting
	Appendix A:  Keyboard Shortcuts for Desktop
	Appendix B:  Guest Client Usage
	Appendix C:  Multi-Device Presence
	Appendix D:  Third-Party Software and Copyright
	Appendix E:  Acronyms and Abbreviations

